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Outlook Overview:

Welcome to MS Outlook. Outlook is a desktop information manager designed to assist you in
sending and managing electronic mail, tracking contacts, as well as scheduling and managing
appointments, meetings, events, and tasks.

Because Outlook is a product of Microsoft, it follows all the conventions of the other Microsoft
products. Most of the screens are organized and look like the other Microsoft applications you
have been using.

Standard Features:

In Outlook, information is organized into folders.

In the FOLDER VIEW, you see all of your folders at once in the Folder List.
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In the OUTLOOK BAR VIEW, your folders are separated into sections, Outlook Shortcuts, My
Shortcuts and Other Shortcuts.

The folders listed in the Outlook shortcuts provide quick access to any of the folders. These
include:

Inbox –
Create, send, forward and reply to email messages
Organize messages

Calendar –
Create appointments
Plan meetings or events
Review tasks

Contacts –
Create, store, and gain access to names, addresses and other contact information

Tasks –
Create and manage To Do/Tasks items
Assign tasks to yourself or others in teams, departments, or organizations

Deleted Items –
Manage all deleted items
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Contacts:

Outlook gets email addresses from the Contacts folder. Besides email addresses, you can keep
street addresses, web page addresses, and phone numbers of all types. Basically, the information
contained in Contacts can be quickly accessed for keeping in touch with your client base.

Adding Contacts:

1.  Click on the Contacts icon or folder.

2.  Click on the New Contact icon.
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Or

a.  Create a contact from an e-mail message you receive
1. Open the e-mail message that contains the name you want to add to your contact

list.

2. In the From field, right-click the name you want to make into a contact, and then
click Add to Contacts on the shortcut menu.

3.  Complete all the pertinent fields and all the other fields in the contact screen. Remember, the
more information you enter, the greater the future value.

4. Click Save and Close.
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An arrow or drop-down arrow indicates there are selections that you can use to save you time
and provide consistency in data.

Note: You may enter up to three E-mail addresses for each contact. The format for this will be
the name followed by the @ sign followed by the host.domain

An example of an email address would be: joeschmoe@iowarealty.com or
jerryjones@firstrealtyhomes.com.
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Adding A Nickname

You may also add a nickname for your contact.  Nicknames are a convenient way to organize and
address your emails.

To add a nickname:

1. In the Contact View screen select the Details tab.
2. In the Nickname field type the contact’s Nickname
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Viewing Your Contacts:

Your Contacts list can get very long, so Outlook offers a number of different ways to find and view
contact(s).

This is the default view:

1. Customers are
listed alphabetically
by last name
you can scroll
through the list

OR

2. Use the Quick
search buttons to
jump-scroll in the
list
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Creating a Group:

When you regularly send emails to the same group of people, you can create a “group” to save
time and ensure accuracy of email addresses.  A contact must exist prior to becoming a member
of a group.

If you wanted to email all of the CRS’s in your office, you can create a group and email them all at
once.

In a message, recipients see their names and the names of all other recipients on the To… line of
the message.

NOTE: In Outlook 2000, groups are referred to as Distribution Lists.

To create a Distribution List:

From the Contacts folder:

1. Click Actions

2. Click New Distribution List

This is the
Distribution List icon
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5. Enter a List name in the Name box.
You will want to name it so you can
remember who is in the group.

6. Choose Select Members…
button

7. Click on a contact name and choose
Add->

NOTE:  This just adds
Members to the list; you can
still email them individually.

* The list on the left is the list you
can choose from for your
Distribution List.

* The list on the right is the people
that are in your Distribution List.

8. When you have added everyone to
the list, click OK.
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9. Click Save and Close

To Add/Edit/Delete Members On A Distribution List:

Once a distribution list is created, it is easily updated to reflect changes in the group. To update an
existing list:

1. Click the
Contacts icon or
folder

2. Double click the
Distribution List
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3. Click on
Select Members…
button

To ADD a member:

4a. Double click on the
member name in the
left window, it will move
them to the list on the
right.

To DELETE a
member:

4b. Double click on the
member name in the
right window, this will
move it to the list on the
left.

5. Click OK.
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6. Click
Update Now

7. Click
Save and Close
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Email
This section provides a basic overview of using the Outlook email functions. It explains the
processes of addressing the email, and replying and forwarding messages.

Inbox

1. Make sure Inbox is highlighted in your list
of folders or icons.

To Compose a Message or Send an Email

1. Click the New button at the top left of your toolbars.
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3. Enter the email address:

There are a number of ways to enter the email address in the To… or Cc… fields.
A.  Type the full email address
ex: jerryjones@iowarealty.com

OR

B.  Type the Nickname in the To: box.
Ex: Joe

C. Click the To… box
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4. Click on the name you want to email and click the appropriate buttons…

To->,

or

Cc->,

NOTE: CC means
“Courtesy Copy” or “Carbon Copy”
and is used to keep someone in the
loop of the discussion.

or

 the Bcc->
address box.

NOTE: Bcc means “Blind Courtesy
Copy” or “Blind Carbon Copy” and
is sent covertly—no one who gets
the message knows who got blind
copies.

5. Click OK.
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OR

 Add a contact after typing in the email address

1. After you type the email
address, hot the Tab key on
your keyboard.

2.  Right-click the address and,
from the menu options, click
Add To Contacts.
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3. Enter the
contact
information.

4. Click
Save and
Close



Outlook

Page 21

Once an address has been entered, complete the email by entering the subject and message.

Enter Your Message Text:

1. Enter a brief description of your message in the Subject area. The Subject information can be
seen in a summary of the recipient’s Inbox providing information on the topic as well as the
urgency of the message.

NOTE: Research indicates that messages with no subject are typically read last.

2. Enter the body of the message.

Customize Your Inbox

There are several options for customizing your Inbox. Most are beyond the scope of this manual.
However, there are some that may be important for you to add or change.

1. Adding Bcc: Field

If you do not see a Bcc: field and find it necessary to add this, open a new message:

2. Click on View

3. Click on “Bcc Field”:
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To Read A Message

1. Double click on the message you want to open.

Reply and Forward A Message

Most of the messages you receive will typically need a reply and some will need to be shared with
someone else. Replying and Forwarding are even easier than creating a new message.

To Reply to a message:
1. Open the message you want to Reply to.
2. To reply to only the sender of the message,
click Reply.

NOTE:  To reply to all of the recipients in
 the To and Cc boxes, click Reply to All
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To Forward A Message:
1. Select the message you want to forward

2. Click Forward
3. Enter recipient names in the To…, Cc… and Bcc… fields

a. To select recipient names from a list, click the To, Cc, or Bcc button.

4. Click Send

Note: You can Forward multiple messages at once, if you select all of them first, then click on
Forward.
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Attaching A Document To Your Email Message

One of the advantages of using email is the fast and efficient transfer of full documents. Attaching
documents in Outlook is very easy.

1. Create and save the document you wish to send to others. (REMEMBER where you saved it.)

2. Create the email

Now,
Attach The Document

From the New Message
window

3. Choose Insert.

4. Choose File.

5. Navigate to the file you want to
6. Double-Click on the file.
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When you have attached a document, an icon will display at the bottom of the memo.

NOTE: You can attach several documents to the same memo. However, a large number/size of
the documents may cause the transfer of the memo to be slow or not be sent at all.
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Managing Your Email

Managing your email boxes, Inbox and Sent Items, is critical for both your organization of
responses as well as the server space.

Right click your mouse on any email.

The options available will be displayed in the pop-up menu.

Flag for Follow Up…
will assign an icon to the side of the message as a visual reminder to
follow up on the message.

If you do not even wish to read the email, you may mark it a
“Mark as Read”  without ever opening it up.

If you choose to delete the memo, choose Delete.

NOTE: When you delete a memo, it will reside in the Deleted Items folder until you remove it

permanently from the Deleted Items folder. This allows you the option of moving the memo back

to its original location. However, it is highly recommended that you empty the Deleted Items
folder at the end of each day.

Organize Your Email in Folders

1. On the File menu, point to New, and then click
Folder.

2. In the Name box, enter a name for the folder.

3. In the Folder contains box, click the type of items
you want the folder to contain- for example Emails
or Contacts.
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4. In the Select where to place the folder list, click the location for the folder.

5. You may now drag and drop emails or contacts into the folders.  This can be useful for
archiving old messages.

Adding a Signature to Your Email
.
A Signature is text that you specify that will be added to each and every outgoing email.  This is
an excellent way to avoid having to sign your name and contact information when sending an
email.

1. On the Tools menu, click Options, and then click the Mail Format tab.

2. Click Signature Picker, and then click New.

In the Enter a name for your new Signature
box, enter a name.

3. Under Choose how to create your
Signature, select whether to start from
scratch or use an existing signature.

To select a file
to base your
signature on,
click Use this
file as a
template and
type the path and
file name in the
box, or click
Browse to select
from a list.

4. Click Next.

5. In the Signature text box, type the text you want to
include in the signature.

You can also paste text to the Signature text box from
another document.

6. To change the paragraph or font format, select the
text, click Font or Paragraph, and then select the
options you want. These options are not available if
you use plain text as your message format.
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Quick Sheet Summary For Email

Creating a New email:

1. On the File menu, point to New, and then click Mail Message
2. Enter recipient names in the To, Cc, and Bcc boxes

a. To select recipient names from a list, click the To, Cc, or Bcc button
3. In the Subject box, type the subject of the message
4. In the text box, type the message
5. Click Send

Reply To A Message

1. Open the message you want to reply to
2. To reply to only the sender of the message, click Reply

NOTE:  To reply to all of the recipients in
 the To…, Bcc…, and Cc boxes, click Reply to All

Forward A Message

1. Click Inbox
2. Select the messages you want to forward
3. Click Forward
4. Enter recipient names in the To, Cc, and Bcc boxes

a. To select recipient names from a list, click the To, Cc, or Bcc button
5. If you are forwarding multiple messages, type the subject of the message in the Subject

box
6. Click Send
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Calendar

Outlook has a powerful calendar feature that allows you to track your schedule, attach memos,
insert contacts and view your list of tasks. Click on the Calendar icon or Folder.
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Set An Appointment

Outlook provides visual cues in setting appointments. This allows you to choose the month, date
and time on the same screen.

To set an appointment, go to the month and date on the calendar

1. Choose the time by
clicking on the line to
the right of the time on
the calendar.

2. Double click on
the blue line to get
the Appointment
Screen
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The Appointment Screen
This screen allows you set/adjust the date/time, add attendees (from Contacts), provide a subject
line and enter a description of the meeting.

An invaluable aspect of it is the opportunity to set the location of the meeting in addition to all the
other components.

Subject: Enter
the Appointment Time: if the dates and

times are not correct,
correct them

Memo: Enter the
notes associated
with the meeting
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Calendar Views

In Outlook, there are several ways of viewing your calendar.
The toolbar at the top of the screen indicates which view is showing.
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Click on the “Work Week” view.

Change to the “Week” view.
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Change to the
“Month” view.

Moving Appointments

Outlook makes it very easy to move appointments using the different views of the calendar.

If you are only changing the time of the appointment, click on the “Day” view.

1. Click on the left outer frame
of the appointment…

2. Click-and-drag the
appointment to the new time.

Notice your cursor changes to
this shape
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To move an appointment to a different date AND time, click on the “Work Week” view.

Click on the left side
(the blue line)
 of the appointment
and drag it to the new
day and time.

Notice your cursor
changes to this
shape

Changing appointment to a different day.

To move an
appointment to a
different day, click on
the “Month” view.

Click on the
appointment
and drag it to the new
date.

Notice your cursor
changes to
this shape
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Recurring Appointments:

There are appointments that occur on a regular basis…these are called “recurring appointments”.
I.e. staff meetings that occur at the same time each week/month.

To set an appointment as a recurring appointment, open the Calendar icon;

1. Click on Day
view.

2. Enter the
appointment

3. Double click on the
appointment

4. Click on
Recurrence…
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5. Check the time to ensure
it is correct.

If it isn’t you can correct it
from this screen.

6. Click the pattern of
recurrence

The most important field in
the Recurrence window is
the range of recurrence.

7. Set the range.
 If you do not enter an “End
by” date, it will default to 10
occurrences.

8. Click OK

NOTE: unless the appointment occurs only once or twice a year, typically, you do not want to
enter a range longer than 12 months.

Enter all other
information on the
appointment
screen. I.e.
reminders,
notes, etc.

9. Click Save and Close
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The appointment
will have the
Recurrence
indicator next to
the appointment.

If the appointment is a recurring appointment, the icon will look like this:

If you set a reminder, the icon will look like this:

To Move One Appointment In A Recurring Series:

If you have a schedule change for one appointment, click on the appointment and drag it to the
new time/day.

You will see a new icon that indicates this is still a recurring appointment but has been moved
from the normal day/time.
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If you double click on the appointment, you will be given the
opportunity to move the whole series.

Click OK

Click on
Recurrence…

Change the information.

NOTE: Remember, this will
change the information for
the ENTIRE series of
appointments.

Click OK
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An alert screen will confirm that all appointments in this series will be set to this date and time.

Click OK.
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Tasks

A task is a reminder to you of items that have to be completed with no specific time allocated for
doing it but one that you wish to track to completion.
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Create a Task:

To create a task, open the Day view of the Calendar.  Look at the bottom right corner of the
screen to see the “Task” area.

Double click on a specific task to show the task details.

Enter the subject
and all other important information.
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Included in the  Due/Start
dates…
is a calendar function that
makes it very easy to assign
dates

NOTE: There is no time
assigned to the defaulted due
date.

Enter any notes
regarding this task.

Click Save and
Close.

NOTE: A Reminder
provides visual
and/or audio alerts when a task due date is
approaching.

Use the calendar to set the date you wish to be
reminded.
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Once you have saved a
task,
you will see it on the
Calendar screen.

When you have
completed a task,
check mark
it off or return to the task
window and change the
status.

Most of the functions
that you have available
for an appointment, are
also available for Tasks.

For example, you can
attach a file…

…and/or set a task as a
recurring event.
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Deleting Completed Tasks:

To delete a task
that is completed.

Right click on the
task and choose
Delete (X)
from the menu
choices.


